ROHS

© 2009-11 Lumagen®, Inc.
503-574-2211
14025 SW Farmington Road
Suite 280
Beaverton, OR 97005-2513 U.S.A.
www.lumagen.com
Limited one (1) year warranty on Lumagen, Inc. products.

Lumagen, Inc. ("Lumagen") warrants (the "Warranty") only to the original retail purchaser ("You"), only that this Lumagen product (the "Product") will be free from defects in material and workmanship for a period of one (1) year from the date of original retail purchase from a Lumagen franchised dealer (the "Dealer"). Lumagen makes no Warranty for Products purchased from other than a Dealer. FAILURE TO RETURN THE WARRANTY CARD MAY MATERIALLY AFFECT YOUR RIGHTS UNDER THIS WARRANTY.

The defective Product must be shipped in the original shipping container, together with a description of the problem, plus Your contact information and proof of the date of purchase, prepaid and insured, to Lumagen. Risk of loss during shipping is borne by You. Purchase date is subject to confirmation with the Dealer. You must contact Lumagen or the Dealer for shipping instructions.

Lumagen will examine the Product. If Lumagen determines, in it's sole opinion, that the Product is defective in materials or workmanship during the Warranty period, Lumagen will, at its option, repair, or replace with an equivalent, or better, Product at no additional cost, or refund the net original purchase price. All parts that are replaced become the property of Lumagen.

If Lumagen determines that the Product is defective in materials or workmanship during the Warranty period, the Product will be returned to You within a reasonable time after it has been repaired or replaced, freight prepaid. If Lumagen determines the Product is not defective in materials or workmanship during the Warranty period, You will be charged for the examination, and the Product will be returned to You, within a reasonable time, C.O.D. for an amount that includes the examination, C.O.D. and shipping charges.

This Warranty does not include service or parts to repair damage caused by, in Lumagen’s sole opinion, acts of God, acts of war, accident, misuse, negligence, inadequate packing or shipping procedures, applied voltage in excess of rated maximum, appearance of cabinetry not directly attributable to defects in materials or workmanship, for any modifications to the Product, or if the serial number has been removed or defaced.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED. IF THE PRODUCT IS DEFECTIVE IN WORKMANSHIP OR MATERIALS DURING THE WARRANTY PERIOD, THE SOLE REMEDY SHALL BE REPAIR OR REPLACEMENT AS SPECIFIED ABOVE. IN NO EVENT SHALL LUMAGEN BE LIABLE FOR AN AMOUNT MORE THAN THE ORIGINAL PURCHASE PRICE OF THE PRODUCT. LUMAGEN SHALL NOT BE LIABLE FOR OMISSIONS OR ERRORS IN ITS DOCUMENTATION OR SOFTWARE. LUMAGEN RESERVES THE RIGHT TO MAKE CHANGES TO ITS PRODUCTS AND DOCUMENTATION WITHOUT NOTICE.

TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL LUMAGEN, ITS SUPPLIERS, OR ITS DEALERS, BE HELD LIABLE FOR ANY LOST REVENUE, LOST PROFIT, SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL, OR PUNITIVE DAMAGES, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY, RESULTING FROM THE USE OF, OR INABILITY TO USE, THIS PRODUCT, EVEN IF LUMAGEN, ITS SUPPLIERS, OR ITS DEALERS, HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Some jurisdictions do not allow exclusion or limitation of consequential damages, so the above limitations may not apply to You.

All implied warranties are expressly disclaimed. If held otherwise by a court of law, all implied warranties are limited to the duration of this express Warranty. Some jurisdictions do not allow the limitation on how long an implied Warranty lasts, so the above limitation may not apply to You. This Warranty gives You specific legal rights, and You may also have other rights, which vary from jurisdiction to jurisdiction.

Cut on line below and mail completed Warranty registration to Lumagen.

WARRANTY REGISTRATION

Name: _______________________________
Address: ________________________________
________________________________________
________________________________________
Email: ________________________________

Product name: ____________________________
Serial Number: ___________________________
Purchase date: ___________________________
Dealer name: ___________________________
LEGAL NOTICES:

TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL LUMAGEN, ITS SUPPLIERS, OR ITS DEALERS, BE HELD LIABLE FOR INJURY TO PERSONS OR PROPERTY, ANY LOST REVENUE, LOST PROFIT, SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL, OR PUNITIVE DAMAGES, IMPAIRMENT OF OR DAMAGE TO OTHER GOODS, HOWEVER CAUSED REGARDLESS OF THE THEORY OF LIABILITY, RESULTING FROM THE USE OF, OR INABILITY TO USE, THIS PRODUCT, EVEN IF LUMAGEN, ITS SUPPLIERS, OR ITS DEALERS, HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

LUMAGEN SHALL NOT BE LIABLE FOR OMISSIONS OR ERRORS IN ITS DOCUMENTATION OR SOFTWARE. LUMAGEN RESERVES THE RIGHT TO MAKE CHANGES TO ITS PRODUCTS AND DOCUMENTATION WITHOUT NOTICE.

Unless you are experienced in the installation and set-up of high-performance video electronics, we suggest you hire a professional home-theater specialist to do installation and configuration of this product. We recommend that you choose a professional who has been certified by the Imaging Science Foundation™ (ISF).

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules, Canadian ICES-003, and CISPR 22. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Unauthorized modifications to this equipment may void Lumagen's limited warranty and the user's authority to operate this equipment.

Lumagen is a registered trademark of Lumagen, Inc. Vision HDP, Vision HDQ, RadianceXE, RadianceXD, RadianceXS, Radiance Mini and other Lumagen product names, are trademarks of Lumagen, Inc. Other trademarks are the property of their respective owners.

WARNINGS:

- Do not defeat the safety features of the power supply or power cord, such as, but not limited to, removing the ground pin connection.
- Do not open, insert objects into, or spill liquid into, this equipment.
- Do not block the cooling vents.
- Do not program an output resolution that exceeds the maximum specified refresh rate of the attached television, or projector.
- Improperly set gray-bar intensity may accelerate screen burn-in. Consult a home-theater specialist for help setting gray-bar intensity.
# Table of Contents

## SECTION 1 – INTRODUCTION
- Document Conventions and Menu Navigation ................................................................. 1
- Unpacking .......................................................................................................................... 2
- Verify that your box contains the following items ........................................................... 2
- Remote Control Battery Installation .................................................................................. 2
- Installation Guidelines ..................................................................................................... 2

## SECTION 2 – OVERVIEW
- FRONT PANEL .................................................................................................................. 3
- REAR PANEL .................................................................................................................... 3
- HDMI CONNECTIONS ..................................................................................................... 3
- MISCELLANEOUS CONNECTIONS ................................................................................. 3
- Remote Control ................................................................................................................ 4
- Block Diagram .................................................................................................................. 5
- Configuration Memories .................................................................................................. 6

## SECTION 3 – QUICK START GUIDE
- INSTALLATION INSTRUCTIONS ..................................................................................... 7
- System Configuration Examples ....................................................................................... 8

## SECTION 4 – BASIC COMMANDS
- Power .................................................................................................................................. 9
- Input Selection .................................................................................................................... 9
- Configuration Memory Selection ..................................................................................... 9
- Input Aspect Ratio Selection ............................................................................................. 9
- Image Zoom ....................................................................................................................... 9
- Status Screen .................................................................................................................... 10
- On-Screen Help ................................................................................................................ 10
- Quick Keys ....................................................................................................................... 10

## SECTION 5 – VIDEO CONFIGURATION
- VIDEO OUTPUT SETUP MENU .......................................................................................... 11
- CUSTOM MODES MENU .................................................................................................... 12
- Output Mode – Global Presets .......................................................................................... 12
- Exact Output Timing ........................................................................................................ 12
- Rate Match ....................................................................................................................... 12
- CMS MENU ..................................................................................................................... 12
- Gamma Factor .................................................................................................................. 12
- Color Gamut ...................................................................................................................... 12
- Grayscale and Gamma ...................................................................................................... 12
- Color Decoder .................................................................................................................. 12
- Black Level ....................................................................................................................... 13
- White Level ...................................................................................................................... 13
- STYLES MENU .................................................................................................................. 13
- Output HDMI Format ....................................................................................................... 13
- Color Format .................................................................................................................... 13
- Dither ................................................................................................................................. 13
- Mask ................................................................................................................................. 13
- Shrink ............................................................................................................................... 13
- Screen Aspect Ratio ....................................................................................................... 13
- Graybar Intensity ............................................................................................................. 14
- 3D Glasses Adjust ........................................................................................................... 14
- MISC OUTPUT SETTINGS ............................................................................................... 14
- 3D Output EDID Configuration ....................................................................................... 14
- Sync Polarity .................................................................................................................... 14
- Copy Output Settings ..................................................................................................... 14
- HDMI Input Setup .......................................................................................................... 14
- HDMI Physical Input ...................................................................................................... 14
- HDMI Video Type .......................................................................................................... 14
- HDMI Level ..................................................................................................................... 15
- HDMI input EDID Display Information .......................................................................... 15
- HDMI input hotplug mode ............................................................................................. 15
- Auto Aspect ..................................................................................................................... 15
# Table of Contents

**INPUT PICTURE CONTROLS** .......................................................................................................................... 16  
Black and White Levels ....................................................................................................................................... 16  
Color Format ....................................................................................................................................................... 16  
Color and Hue ..................................................................................................................................................... 16  
Y/C Delay .......................................................................................................................................................... 16  
**INPUT SIZE CONTROLS** .................................................................................................................................. 16  
Scale Bias ............................................................................................................................................................ 16  
Input Sizing ........................................................................................................................................................ 16  
Vertical Shift ..................................................................................................................................................... 17  
Non-linear Stretch ............................................................................................................................................. 17  
Input Masking .................................................................................................................................................... 17  
**INPUT CONTROL MENU** .................................................................................................................................. 18  
Deinterlacing Mode ........................................................................................................................................... 18  
Inter Frame Motion Detection (IFMD) ................................................................................................................ 18  
Deinterlacing Field Flip ..................................................................................................................................... 18  
Genlock .............................................................................................................................................................. 18  
Game Mode ......................................................................................................................................................... 18  
Reinterlace .......................................................................................................................................................... 18  
**INPUT ENHANCEMENT CONTROLS** ............................................................................................................. 18  
Sharpness .......................................................................................................................................................... 18  
Noise Reduction ............................................................................................................................................... 19  
Adaptive Contrast .......................................................................................................................................... 19  
Copy Enhancement Settings .............................................................................................................................. 19  
**MISCELLANEOUS INPUT CONTROLS** ........................................................................................................ 19  
Input Label ........................................................................................................................................................ 19  
Copy Input Settings ....................................................................................................................................... 19  
Selecting an Output Configuration for an Input Memory ............................................................................. 19  
**SECTION 6 – AUDIO CONFIGURATION** ..................................................................................................... 20  
Introduction to the Audio Menu ...................................................................................................................... 20  
Audio Menu Navigation .................................................................................................................................. 20  
Audio Menu Selections ................................................................................................................................... 21  
Audio Menu Structure .................................................................................................................................... 21  
Audio User EDID ............................................................................................................................................... 21  
Input Memory Specific Audio EDID .................................................................................................................. 21  
Audio Source Selection Defaults ...................................................................................................................... 21  
**SECTION 7 - CALIBRATION** ......................................................................................................................... 22  
Set the display’s picture controls to neutral ......................................................................................................... 22  
Calibrate black and white levels using display controls .................................................................................. 22  
Color Management ....................................................................................................................................... 23  
Calibrate 100 IRE white to D65 using the display’s controls .......................................................................... 23  
Calibrate Radiance primary color gamut ........................................................................................................ 23  
Calibrate Radiance grayscale and gamma ......................................................................................................... 23  
Iterate the gamut and grayscale/gamma calibrations ....................................................................................... 24  
Calibrate Radiance output color and hue .......................................................................................................... 24  
Iterate gamut, grayscale/gamma and color/hue calibrations ........................................................................... 24  
Calibrate Radiance input overscan, black, white, color and hue .................................................................. 24  
**SECTION 8 – MISCELLANEOUS COMMANDS** ........................................................................................ 26  
System Settings ............................................................................................................................................... 26  
Menu Mode ....................................................................................................................................................... 26  
Timeouts .......................................................................................................................................................... 26  
OSD Enable ..................................................................................................................................................... 26  
Input Reselect ................................................................................................................................................ 26  
Menu Placement .............................................................................................................................................. 26  
Input Menu ...................................................................................................................................................... 26  
Initial Power State ........................................................................................................................................ 26  
Initial Input State ......................................................................................................................................... 26  
On-Off Message .......................................................................................................................................... 27  
Message Control ........................................................................................................................................... 27  
Test Patterns ................................................................................................................................................... 27  
Remote Control .............................................................................................................................................. 27
Section 1 – Introduction

Thank you for purchasing a Lumagen® Radiance™ video processor. The award winning Lumagen Radiance video processor family boasts the highest-performance video switching, processing and calibration available. This makes it ideal for premium quality high-definition home and commercial theater applications. Lumagen’s Radiance series refines and enhances the video images presented by high definition front projectors, top-level rear-screen and flat-panel displays.

The Radiance family offers 10-bit front-end, and 12-bit back-end, processing, per-pixel standard definition (SD) and high definition (HD) video de-interlacing with adaptive diagonal filtering, No-Ring™ scaling technology that does not add ringing (unlike competing products), MPEG mosquito and block artifact reduction plus “3D” temporal noise reduction for both SD and HD sources. It supports HDMI® 1.4 “3D” and uncompressed audio formats for Dolby-Digital TrueHD™ and DTS Master-Audio™. At the same time Radiance processors can function as a central switching hub for the audio video system. For these reasons, the Radiance™ processor family sets the industry benchmark for switching, calibration and video processing performance.

Key Features

- 10-bit processing for deinterlacing plus a 12-bit calibration pipeline
- Proprietary Lumagen No-ring™ scaling
- Support for HDMI® 1.4 “3D” including anamorphic lens and conversion to a specific 3D output format
- Each input has 4 user configuration memories
- Each input user configuration memory has 8 resolution sub-memories
- Each resolution sub-memory is linked to one of 8 output configurations.
- 2:2, 3:2 and 3:3 pull-down for SD/HD film sources
- Per-pixel SD/HD video de-interlacing
- Adaptive diagonal filtering
- MPEG mosquito and block artifact reduction
- Temporal noise reduction for SD and HD sources
- Output resolution from 480p to 1080p, plus 1080i
- User programmable non-linear-stretch (NLS) mode
- 4:3, LBOX, 16:9, 1.85, 2.35 and NLS input aspect ratios
- Programmable output aspect ratio from 1.10 to 2.50
- Extensive support for anamorphic lenses for both 2D and 3D video
- Automatic detection for NTSC, PAL and SECAM
- Extensive suite of test patterns
- Parametric grayscale and Gamma calibration
- Full CMS (Color Management System) using a 3D linear-gamma color palette
- Programmable input/output color-space
- Y/C-delay calibration
- CUE and ICP filtering
- Eight channel audio up to 192 kHz, DD True-HD™ 5.1, and DTS Master Audio™ 5.1
- IR and RS232 control inputs (See Tech Tip 11 and 12 on the Lumagen.com support page)
- Universal, 100-240V~50/60Hz input power supply
- Power consumption 13 Watts
Section 1 – Getting Started

Document Conventions and Menu Navigation
Commands are selected with the supplied infrared remote or the RS232 serial port. To prevent possible command conflict, only one of these methods of command should be used at a time. See the Serial RS232 Command Interface section for information on serial commands. The infrared remote control command notation is described below:

- Remote buttons are named as shown on the remote in a bold font. Example: **MENU**.
- For comma separated lists, press the buttons in the sequence shown.
- For parenthesized lists, select one button from the list.
- For square-bracketed lists, press the buttons as needed.
  Example: For the list \[/headleft, /headright, /headup, /headdown\], press the arrow keys as needed.

- For menu commands press the **MENU** button. The **>** and **<** arrow keys are used to select the function. The **>** arrow key (or OK) is used to enter sub-menus. This is shown as: **MENU** → **MenuItem** → **MenuItem**. The **<** arrow key (or **EXIT**) steps up one menu level.
- Numerical entries are listed as **value**. The **<** arrow key acts as a backspace key.
- Some commands are activated immediately without the need to press **OK**. Other commands must be explicitly accepted by pressing **OK**. If needed, **OK** is listed as part of the command, and will complete the command and return the menu to one level higher in the menu system.
- For many commands, pressing **EXIT** cancels a partially completed command and returns to one level higher in the menu system. For advanced commands changes are completed from within the command and **EXIT** just returns to one level higher in the menu system.
- There are four independent configuration memory types for each input (**MEMA**, **MEMB**, **MEMC** and **MEMD**). The input setup and output resolution/timing can be set independently for each memory. To program an input memory, first select the input, then select the desired configuration memory and use the menu system to configure.
- Some menu commands are only available when their associated input is selected.
- Before changes are saved, they can be discarded by entering standby (**STBY**) mode.
- A Save must be performed after any changes or all changes will be discarded the next time the unit enters standby (**STBY**), or power is lost. To save press **MENU**, **^**, **OK**, **OK**, **OK**.

Unpacking
- Unpack the box.
- Make sure that you remove all of the accessories from the packing.
- Save the box and packing materials in case you need to ship your Radiance.

Verify that your box contains the following items
- Lumagen Radiance video processor
- Universal power-supply, INPUT: 100-240V~50/60Hz
- Remote control
- AAA Batteries (2)
- Owner’s Manual
- RS232 Null-modem cable

Remote Control Battery Installation
1. Locate the battery compartment on the back of the remote control.
2. Move the locking tab to open the door.
3. Remove the old batteries (if applicable).
4. Install two new AAA batteries, observing the battery polarity shown in the battery compartment.
5. Replace the battery compartment cover.

Installation Guidelines
- Install the Radiance on a flat, level surface such as a table or shelf.
- Select a well-ventilated, dry location.
- Verify that the cooling vents are clear of obstructions to provide convection cooling.
- Only use the Lumagen approved power supply.
- Avoid sudden temperature changes, temperature extremes and excessive humidity.
- Unplug power to the Radiance before cleaning.
Section 2 – Overview

Front Panel

<table>
<thead>
<tr>
<th>LED</th>
<th>IR Sensor</th>
</tr>
</thead>
</table>

The front panel has a light-emitting-diode (LED) indicator, which is red when the unit is in “standby” and, by default, is green when the unit is “on.” Note that the green “on” indicator can be turned off if preferred.

Rear Panel

<table>
<thead>
<tr>
<th>5 VDC</th>
<th>RS-232</th>
<th>HDMI Out</th>
<th>HDMI In 1</th>
<th>HDMI In 2</th>
</tr>
</thead>
</table>

There are two HDMI video inputs and one HDMI video output. Additional connections are provided for RS232 command input/update, plus the 5 VDC power input. These connections are described below.

HDMI Connections

1. HDMI SD/HD Output. HDMI1 supports video resolutions from 480p/576p up to 1080p60.
2. HDMI SD/HD Inputs. Supports resolutions from 480i/576i up to 1080p60
   Note: CEC pass-through connected from HDMI inputs to the HDMI Output.

Miscellaneous Connections

1. RS232. Used for command input and for software update (See Tech Tip 6 and 11).
2. Power Input (5 Volts DC)
Section 2 – Overview

Remote Control

Power / Standby
ON  Power On
STBY  Standby

Navigation Control
CLR  Clear menu or partial commands
HELP  Display context-sensitive help
EXIT  Go back one menu level
OK  Enter/Accept command, display info screen
^  Menu navigation / zoom in
v  Menu navigation / zoom out
<  Menu navigation / input aspect
>  Menu navigation / input aspect

Numeric Entry
1-9  Input 1 to 9
+10  Input 10 and greater

Picture-In-Picture (PIP)
OFF  Not applicable
SEL  Not applicable
SWAP  Not applicable
MODE  Not applicable

Input Aspect Ratio
4:3  4:3 (1.33) aspect ratio
LBOX  Letterbox
16:9  16.9 (1.78) aspect ratio
1.85  1.85 aspect ratio
2.35  2.35 aspect ratio
NLS  Non-Linear-Stretch

Misc Buttons
INPUT  Precedes input # selection
ZONE  <not implemented>
ALT  Alternate info screens
PREV  Previous output

Configuration Memories
MEMA  Memory A
MEMB  Memory B
MEMC  Memory C
MEMD  Memory D
Section 2 – Overview

Block Diagram

The function of the Radiance is to act as a video switch, process the selected video source and then output video in the appropriate format and resolution. Standard definition (SD), enhanced-definition (ED), high-definition (HD) video inputs, plus a number of PC formats are supported. Video inputs are converted to progressive video (if necessary) and are then scaled to the video output resolution.

Interlaced video has been in use for more than 50 years and is still the most common video format. It displays half of the lines of picture information each sixtieth (or fiftieth) of a second. Each half of the image is called a field and displays either all the even lines, or all the odd lines. So, an entire image, called a frame, takes a thirtieth (or twenty-fifth) of a second to display on the screen. An "i" suffix on the resolution specification is used to indicate interlaced formats.

In contrast, progressive video presents each frame as a whole. A "p" suffix on the resolution specification is used to indicate progressive formats. Converting interlaced video to progressive video is referred to as "deinterlacing."

The Radiance is comprised the following major functional sections:

- Video input selection and video decoding
- Video deinterlacing
- Video filtering and scaling
- Video output of HDMI digital video

The functional blocks are shown below.

HDCP encryption is supported for the HDMI inputs. If the signal is encrypted, the HDMI inputs are decrypted, processed, scaled and then re-encrypted for output as HDMI. For HDCP encrypted inputs, a HDCP capable display is required.

If the video input is interlaced, it is first deinterlaced into a progressive format. User enabled noise reduction algorithms are then applied. Proprietary No-ring™ scaling algorithms are used to scale the resulting progressive video to the optimal size for the display.

As part of the scaling process, digital filtering is used to enhance the image detail. This enhancement allows standard definition inputs, such as DVDs, to appear to be much higher resolution. This is especially valuable when standard-definition sources are viewed on the large screen sizes common in home theaters.

Commands can be sent to the Radiance by infrared remote or via the serial RS232 port. The RS232 port is used for software updates. Setup is done with the on-screen menu. User functions (e.g. select input) use direct commands.
Configuration Memories

To understand how the Radiance functions, it is important to note that setup and calibration parameters are split into “input memories” and “output configurations.” Input memories control video source setup. Output configurations control display setup and calibration and are specified by selecting a Mode, CMS and Style for each input, input User memory, input resolution, and 2D/3D input.

The Radiance has four input memories (MEMA, MEMB, MEMC and MEMD). Each input memory has eight sub-memories that are automatically selected for input resolutions of 480, 576, 720p, 1080i50, 1080i60, 1080p24, 1080p60 and Other. The “Other” memory is reserved as a “catch-all” for unspecified resolutions.

The following applies to software revision 102910, and later: Each Input sub-resolution memory can be independently linked to any one of the (8) output modes, (8) CMS and (8) Style memories. They store setup data for the video display setup and calibration. In the factory default condition all input sub-resolution memories are linked to “Mode 0,” “CMS 0,” and “Style 0.” To change these enter MENU → Output→ Output Setup → OK. These settings can be changed for each input sub-resolution memory. To “Save” new settings, enter MENU → Save → OK → OK → OK.

Default “Input Memory” to “Output Configuration” (for 102910, or later, software)
Section 3 – Quick Start Guide

Installation Instructions

1. Install two AAA batteries in the Lumagen Remote Control.
2. Connect the video sources to the HDMI inputs on the receiver (or HDMI Switch).
3. Connect the output of the receiver (or HDMI Switch) to the HDMI Input 1 on the Radiance.
4. Connect the Radiance HDMI output to the display.

5. Plug the DC power cord from the Radiance power supply into the DC power jack on the back of the Radiance. Then connect the power cord to the Radiance power supply and plug it into a wall outlet.
6. Turn the other equipment on and use the Radiance remote control to turn the Radiance on.
7. Select the desired Radiance input using the Radiance remote control. The six video inputs are numbered 1 to 6 (2 physical and 4 virtual inputs). For all inputs press the "Input" button and then press the corresponding input number button on the remote.
8. If desired the input selection can be assigned to different physical HDMI inputs. This can be useful if a receiver or HDMI switcher has several sources and feeds a single input on the Radiance. Different settings and calibrations for several virtual HDMI inputs can be stored for the same physical inputs. For example, physical input 2 and virtual inputs HDMI 3 through HDMI 6 can be assigned to physical input HDMI 1. The command is:
   MENU → Input → HDMI Setup → Physical In → (1, 2)
9. Audio inputs can be associated with the active input using the following command:
   MENU → Input → Audio Setup → Source → (select audio input) → OK
10. Make sure the appropriate HDMI input on the display/projector is selected, and the selected source device is outputting active video.
11. You should now have an image on your display/projector. Note: The Radiance automatically selects the appropriate output resolution and frame rate for HDMI/DVI displays and projectors (including 24p when supported by the display/projector), when connected according to these instructions.
12. The default output aspect ratio is 16:9 (i.e. 1.78:1). No output aspect ratio selection is needed for 16:9 displays or projectors. For other output aspect ratios use the following command:
   MENU → Output → Styles [Style] → Aspect Ratio → (aspect ratio) → OK
System Configuration Examples
The most common configurations using the Radiance Mini are shown below.

1. Receiver in front of Radiance.
Use a receiver in front of the Radiance to switch the video sources. Connect the display to the Radiance HDMI Output. The number of video sources that can be connected, is only limited by the number of video inputs on the receiver. Note: Be aware that some receivers add artifacts to video even if they are in "pass-through" mode.

2. Audio and Video routed separately.
For one or two video sources you can route the audio and video separately to the Radiance and a receiver. Connect the display to the Radiance HDMI Output.

3. Radiance in small system.
This configuration shows a small system, where the speakers on the display are used for the audio. Two video sources can be connected to the Radiance. Connect the display to the Radiance HDMI Output.
Section 4 – Basic Commands

Power
Turn power on by pressing the ON button, on the Radiance remote. Place the Radiance in standby-mode by pressing STBY.

Input Selection
The HDMI video inputs are numbered 1 through 6 (two physical inputs and four virtual inputs). Press the “Input” button and then press the corresponding number button on the remote.

Shortcut:  
If the neither the menu or status screen is displayed on the screen, inputs can be selected by just pressing the corresponding number button on the remote.

If desired, the “Input” button can be programmed to display a screen with the inputs listed as a menu-table. Then the desired input can be selected either with the number keys, or by using the arrow keys to highlight the desired input and then pressing the OK button. The command to enable the input menu is:

MENU → Other → Menu control → Menu Options → Input Menu → (Off, On)

Configuration Memory Selection
Each input has four configuration memories. These are referred to as memory “A,” “B,” “C,” and “D.” To select one of these memories press MEMA, MEMB, MEMC, or MEMD, respectively. Note, RS232 codes are provided to directly access these memories. Each input memory has eight input “sub-memories” that are automatically selected based on the input resolution and 2D/3D input video format.

Each configuration memory, and sub-memory, is independent of the other memories. To allow the memories to be used for mode selection (e.g. day/night), the memory type remains unchanged when a new input is selected. (i.e. If input 1 memory B is active, pressing “Input, 2” selects input 2 memory B).

Input Aspect Ratio Selection
The input source aspect ratio can be selected by pressing the 4:3, LBOX, 16:9, 1.85, or 2.35 button. To use the NLS feature, press “4:3, NLS”, “16:9, NLS”, or “1.85, NLS”.

- Use 4:3 for standard definition full-screen material.
- Use LBOX for “letterbox” standard definition material, such as analog-television movies shown with black bars above and below the image.
- Use 16:9 for material labeled as “Enhanced for 16:9 televisions”.
- Use 1.85 for material labeled as “Aspect ratio 1.85”.
- Use ‘Alt’ 1.85 for material that is “Aspect ratio 1.85 letterboxed in a 16:9 (1.78) window”.
- Use 2.35 for material labeled as “Aspect ratio 2.35”.
- Use NLS to apply a horizontal non-linear stretch, to stretch 4:3 to 16:9, or 16:9 or 1.85 to 2.35.

NOTE:  
Make sure the "display aspect ratio" setting is 16:9 in the setup menu of all video sources (e.g. DVD players or set top boxes), even if your display is not 16:9.

Image Zoom
After the input aspect ratio has been selected, the image can be zoomed in to better fit the screen. The zoom function uses the ▲ and ▼ arrow buttons. When the menu is off, by default, the ▲ arrow button zooms in and the ▼ arrow button zooms out.
Section 4 – Basic Commands

Status Screen
Pressing "OK" when the menu is off displays an on-screen information message as shown in the example below.

<table>
<thead>
<tr>
<th>RadianceMini-3D Info Pg 1 (for Pg 2 press Ok)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW Rev:xxxxxx Serial:xxxxxxxxx</td>
</tr>
<tr>
<td>Input 1A Output</td>
</tr>
<tr>
<td>Resolution: 480i 1080p</td>
</tr>
<tr>
<td>Refresh: 59.94Hz 59.94Hz</td>
</tr>
<tr>
<td>Color Fmt: YCbCr 422 RGB</td>
</tr>
<tr>
<td>HDCP: On On</td>
</tr>
</tbody>
</table>

Pressing “OK” when the information screen is displayed, will display a second status screen as shown in the example below.

<table>
<thead>
<tr>
<th>RadianceMini-3D Info Pg 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio:HDMI1</td>
</tr>
<tr>
<td>In aspect=16:9 Out aspect=1.78 Zoom=15%</td>
</tr>
<tr>
<td>X scaler: On AdjInHres: 720 OutHRes:1920</td>
</tr>
<tr>
<td>Y scaler: On AdjInWres: 418 OutVRes:1080</td>
</tr>
<tr>
<td>Genlock: currently off</td>
</tr>
<tr>
<td>Deinterlacing:NA Game mode:Off</td>
</tr>
</tbody>
</table>

On-Screen Help
Pressing, "HELP" when the menu is displayed, displays on-screen help information for the currently highlighted menu item for many of the menu options.

Quick Keys
Provides a menu to use for basic remotes that have limited buttons, The ‘Quick Keys’ menu has buttons for input aspect ratio (4:3, LBOX, 16:9, 1.85, 2.35, NLS), set zoom (Zoom+, Zoom-) and select the user memory (MemA, MemB, MemC, MemD). The “Quick Keys” menu duplicates the function of pressing the corresponding buttons on the Lumagen remote. There are also buttons to control 3D (off, SbyS, TopB).

Section 5 – Video Configuration

By default the output is set to “Auto” The selection “Auto” means the Radiance automatically reads the EDID for the device connected to the output and automatically selects the appropriate output resolution. That is, if an active device is connected to the output, the EDID from that device is read to determine the optimal video output resolution and the Radiance automatically selects the specified resolution.

For “Auto” modes the output vertical rate is selected based on the input vertical rate. For example, input formats 480i60, 720p60, 1080i60 automatically select a vertical output rate of 60 Hertz. Input formats 576i50, 720p50, and 1080i50 automatically select a vertical output rate of 50 Hz. For a 1080p24 input format a 24 Hz output vertical rate is selected if the display supports a 24 Hz output vertical rate, otherwise a 60 Hz rate is selected.

For analog displays and digital displays, that do not properly support EDID, the output mode must be selected using the commands shown below.

### Video Output Setup Menu

The Video Output Select Menu is used to select output settings (Mode, CMS, and Style) based on the input number, input memory, and input video mode. The Video Output Select Menu does not affect the audio settings. See the Audio Configuration section for information on configuring audio modes.

Once selected, the parameters for the Mode, CMS, and Style are changed using the MENU → Output Setup → (2D/3D) → Ok → (Mode, CMS, Style) menu. In order to preserve continuity, with older software, the same menu can also be accessed at MENU → Input → Video Setup → [Resolution] → (2D/3D) → Ok → (Mode, CMS, Style).

First highlight the ‘2D’ or ‘3D’ row and press “Ok” to edit.

Next highlight the input condition entry that you want to edit.

Press the “^” and “v” buttons to set the input number, input memory, and input mode. For any of the 3 input conditions you can press “4” to enter ‘All’ as the condition. This allows you to apply the output setup to multiple input conditions.

You can leave any of the output settings unchanged by selecting the ‘---’ option for that output setting.
Section 5 – Video Configuration

Custom Modes Menu
The Custom Modes store settings for the timing of HDMI video mode that drives the display. There are menus to select standard HDMI modes or custom timings for HDMI modes.

Output Mode – Global Presets
This command is not generally needed. However, it can be useful when driving displays that do not report EDID and where no video is visible until a specific format is sent. It changes the Output Mode for all inputs and input memories. Select the Output Mode from the table below. The command is:

MENU → Output → Custom Modes → [Custom] → Select Mode → OK

The direct commands to select output resolution are:

- 480p60:  MENU 0 2 1 OK
- 540p60:  MENU 0 2 2 OK
- 720p60:  MENU 0 2 4 OK
- 768p60:  MENU 0 2 5 OK
- 1080p60: MENU 0 2 7 OK
- 1080i60: MENU 0 2 8 OK

Exact Output Timing
After selecting an output format, its timing can be modified on a pixel basis. Do not change the timing using this menu unless it is really needed. Some digital displays lose picture if timing is changed by even a single pixel. The command is:

MENU → Output → Custom Modes → [Custom] → Timing → Mode Timing

Rate Match
Some material may be sourced at 24.00/60.00 Hertz refresh rates instead of the standard 23.98/59.94 Hertz rates. It is desirable to slightly alter the output rate to match the input rate as long as the display works with these different rates. The default setting is ‘Off.’ Use ‘Off’ if your display will not accept these rates. The command is:

MENU → Output → Custom Modes → [Custom] → Timing → Rate Match → (On, Off)

CMS Menu
The Color Management System (CMS) stores settings used to calibrate the color of the display. There are menus to calibrate the position of the primary/secondary color points, calibrate grayscale tracking, calibrate the gamma curve, and compensate for red/green push errors.

Gamma Factor
The Gamma Factor adjusts the gamma of the video output up or down. Since the Radiance is in the middle of the video chain, its default goal is to not affect the image Gamma and so the default Radiance gamma is 1.00. Changing the Gamma Factor allows the Radiance a "coarse correction" control for display Gamma. It should be set to (Desired_Gamma / Measured_Gamma). The command is:

MENU → Output → CMS’s → [CMS] → Gamma Factor → OK

Color Gamut
Calibrate the primary and secondary color points using a linear-Gamma 3D color lookup table. Lumagen recommends calibrating the 75% points. A color probe is necessary for proper adjustment. The command is:

MENU → Output → CMS’s → [CMS] → Color Gamut

Grayscale and Gamma
Allows the parametric adjustment of 2, 5, 11, 12 or 21 color temperature points to adjust the grayscale and gamma for the display. The command is:

MENU → Output → CMS’s → [CMS] → Gray/Gamma

Color Decoder
Used to correct color decoder errors in the display that cause red and green push. This adjustment should be used in conjunction with the color and gamut controls. The command is:

MENU → Output → CMS’s → [CMS] → Color Decoder
Section 5 – Video Configuration

Black Level
Used to set the black level for the display. Normally the “Brightness” control on the display is used to set the black level. The command is:

MENU → Output → CMS’s → [CMS] → Black → Ok

White Level
Used to set the white level for the display. Normally the “Contrast” control on the display is used to set the white level. The command is:

MENU → Output → CMS’s → [CMS] → Color Gamut

Styles Menu
The styles stores settings for the HDMI format that is output to drive the display. There are menus to set the HDMI format, size, position, aspect ratio, and graybars for the image on the display.

Output HDMI Format
You can specify the digital output range as "RGB-PC level" (e.g. for 8-bit 0 to 255) or "RGB-Video level" (e.g. for 8-bit 16 to 235). "YCbCr 422" is the recommended output format. For the HDMI RGB output, setting the level as video allows blacker-than-black and whiter-than-white. The command is:

MENU → Output → Styles → [Style] → HDMI Format → Type → (YCbCr422, YCbCr444, RGB-PC level, RGB-Video level)

Color Format
Sets the outputs color format. It should be set to match the display. Normally Bt.601 is used for SD/ED modes and Bt.709 is used for HD modes. For RGB sources Auto should be used. The command is:

MENU → Output → Styles → [Style] → HDMI Format → Color Format → (Auto, Bt.601, Bt.709)

Dither
Some fixed pixel displays show contouring on images that have gradients because the actual repixel depth of each pixel is limited. The dither control can be used to enhance the resolution of the display and reduce contouring. Dither position sets the bit size of the pixel for dithering. Orientation controls the frame-to-frame randomization and can be fixed of dynamic. Masking can be turned on to clear the lowest bits after the dither addition. The command is:

MENU → Output → Styles → [Style] → HDMI Format → Dither

Mask
The “mask” command allows you to “blank” the edges of the video image on the output without changing its position or scaling. This is useful to blank bad pixel data from the source that shows on screen, when you want to keep the “pixel perfect” setup (i.e. no scaling). The gray level of the mask is adjustable from black to white in sixteen steps. The command is:

MENU → Output → Styles → [Styles] → Mask/Shrink → Mask

Shrink
The “shrink” command allows you to adjust the image size to fit inside a screen masking system. This command is useful for rear-screen and flat-panel displays when the manufacturer uses too much “overscan”. The command is:

MENU → Output → Styles → [Styles] → Mask/Shrink → Shrink

Screen Aspect Ratio
Select the screen aspect ratio. The screen aspect ratio range is 1.10 to 2.50 and is entered in units of hundredths (e.g. 16:9 is entered as 1 7 8). If you have a normal fixed aspect display, select the “Single output aspect” which is the default setting. If you have a movable anamorphic lens, select “Output aspect per input aspect.”

There is a special case when you use NLS input aspect with “Output aspect per input aspect”. When the input aspect is 4.3+NLS the output aspect assigned to the 16:9 entry is used. When the input aspect is LBOX+NLS, 16:9+NLS, or 1.85+NLS the output aspect assigned to the 2.35 entry is used. The command is:

MENU 0 6 (Single output aspect, Output aspect per input aspect) OK xxx OK
Section 5 – Video Configuration

or \( \text{MENU} \rightarrow \text{Output} \rightarrow \text{Styles} \rightarrow \text{[Style]} \rightarrow \text{Aspect Ratio} \rightarrow \text{(Single output aspect, Output aspect per input aspect)} \rightarrow \text{Ok} \rightarrow \text{xxx} \rightarrow \text{Ok} \)

Graybar Intensity

\textit{NOTE: Consult a home theater specialist for assistance setting the graybar intensity.}

Some degree of burn-in will occur on any susceptible display, but this command can help minimize it by allowing the intensity of the graybars to be adjusted. The command is:

\( \text{MENU} \rightarrow \text{Output} \rightarrow \text{Styles} \rightarrow \text{[Style]} \rightarrow \text{Graybar} \rightarrow \text{(Sides, Top/bottom)} \)

3D Glasses Adjust

When using the Radiance to control 3D glasses timing this setting adjusts the timing offset of the 3D glasses. This delay is combined with the global delay setting under the \( \text{MENU} \rightarrow \text{Other} \rightarrow \text{I/O Setup} \rightarrow \text{3D Glasses} \) menu. The command is:

\( \text{MENU} \rightarrow \text{Output} \rightarrow \text{Styles} \rightarrow \text{[Styles]} \rightarrow \text{3D Adjust} \)

Misc. Output Settings

3D Output EDID Configuration

By default the display’s 3D capability is automatically detected using its EDID information. However, some 3D displays do not properly report their 3D capability in their EDID. This command allows the 3D output capability to be manually set. The command is

\( \text{MENU} \rightarrow \text{Output} \rightarrow \text{3D Options} \rightarrow \text{(Off, Auto, On)} \).

Sync Polarity

By default the output sync polarity is selected automatically. This command allows the user to override the automatic selection for each output. The command is

\( \text{MENU} \rightarrow \text{Output} \rightarrow \text{SyncPolarity} \).

Copy Output Settings

This command copies the current output Mode/CMS/Style settings to the selected output Mode/CMS/Style. The command is:

\( \text{MENU} \rightarrow \text{Output} \rightarrow \text{Copy} \rightarrow \text{OK} \)

HDMI Input Setup

After the output is configured, calibrated, and saved, you can calibrate the first input. Note that most often, no input calibration is necessary. After calibrating the first input, you can copy that configuration to all the other configuration memories if desired. Then calibrate the other input. To program one of the independent input memories, select the input, then select the configuration memory and use the menu to configure the input. For example, if memory A been calibrated and a second configuration is needed, start by copying Memory A to memory B for that input to reduce setup time for the second configuration.

HDMI Physical Input

If desired the input selection for HDMI sources can be assigned to different physical HDMI inputs. This can be useful if a receiver or HDMI switcher is used to switch several HDMI to a single input on the Radiance. Different settings and calibrations for several virtual HDMI inputs can be stored for the same physical inputs. i.e. Physical input 2 and virtual inputs HDMI 3 through HDMI 6 can be assigned to physical input HDMI 1. The command is:

\( \text{MENU} \rightarrow \text{Input} \rightarrow \text{HDMI Setup} \rightarrow \text{Physical In} \rightarrow \text{(1, 2)} \)

HDMI Video Type

By default the HDMI input format is detected automatically. For DVI sources that do not report their format, the input format can be selected manually. The command is:

\( \text{MENU} \rightarrow \text{Input} \rightarrow \text{HDMI Setup} \rightarrow \text{Type} \rightarrow \text{(Auto, YCbCr 444, YCbCr 422, RGB)} \)
Section 5 – Video Configuration

HDMI Level
This command specifies if the HDMI inputs use video levels or PC levels. The input video level should be set to match the expected range of your video source. A mismatch can cause the image to be too dark or bright. An output video level mismatch can also have the same effect. The command is:

MENU → Input → HDMI Setup → Level → (Video, PC)

HDMI input EDID Display Information

**NOTE:**
Lumagen recommends using default video EDID or user-defined video EDID. This enables the Radiance to report video EDID back to the sources even when the display is off, and it can also improve power-up and switching speed.

EDID is information that can be read over DVI/ HDMI cables to influence how source devices deliver video, which helps produce an optimal picture. There are 4 settings for the Lumagen EDID interface. The default setting enables all of the display modes the Radiance supports. The *User* defined setting allows the user to individually select which capabilities will be advertised to the source. You can scroll through the list of capabilities with the up/down arrows and toggle advertising the feature with the left/right arrows. With the Passback setting, the Lumagen will read the EDID from the display connected to the output and pass that back to the source. The command is:

MENU → Input → HDMI Setup → Video EDID → (Default, User defined, Passback Out 1)

HDMI input hotplug mode

**NOTE:**
*Do not set Hotplug to "always on" unless necessary since this eliminates the ability of the Radiance to inform the source of a change in the EDID data.*

Hotplug alerts a DVI/HDMI device to downstream EDID changes when toggled. For some devices, such as a PC, it may be necessary to keep hotplug high at all times. The hotplug signal is part of a HDMI/DVI interface. The Radiance provides two hotplug settings, "Normal" and "Always On". The "Normal" behavior is to toggle hotplug signal sent back to the HDMI source when the EDID information needs to be updated. The source will then read the EDID and make any necessary changes. If the device connected to the Radiance output toggles the hotplug to the Radiance then there may be some new EDID information to passback to the sources and, if hotplug is set to "Normal", hotplug on all the inputs may be toggled to achieve this.

Some sources, such as PC’s, stop sending video on HDMI/DVI, or enter sleep mode, when the hotplug signal is not asserted, so setting hotplug on the Radiance to "Always On" is a potential solution. As mentioned above, generally Hotplug should be set to "normal."

Sometimes the connectivity of a system can cause a "hotplug loop." An example of this is when connecting the Radiance output to an audio receiver and then hooking the HDMI monitor output of the receiver to one of the Radiances’ inputs. Then, if the Radiance toggles its Hotplug back to the receiver’s output, the receiver would check the Radiance’s EDID and then toggle its hotplug back to the Radiance to inform it about this new EDID. The Radiance again toggles Hotplug in response. This creates a continuing loop of HDMI activity that may not end.

MENU → Input → HDMI Setup → Hotplug mode → (Normal, Always On)

Auto Aspect

For HDMI sources (not DVI), aspect information may be sent from the source. Enabling HDMI Auto-Aspect allows the source to set the input aspect ratio. You can set "NLS when applicable" (non-linear stretch) in order to stretch the width to fill the screen based on the input and output aspect ratios. The Automatic input aspect ratio selection can be overridden by manually selecting an input aspect ratio. If the "Sticky aspect override" is on, this new aspect will be used until the input is reselected, the Input button is pressed, or a memory button is pressed. If the "Sticky aspect override" is off the next time a different HDMI auto aspect is received the aspect will change to that input aspect ratio. The command is:

MENU → Input → HDMI Setup → Auto Aspect → (On, Off)
Section 5 – Video Configuration

Input Picture Controls

Black and White Levels
To set the input’s black-level (also referred to as brightness) and white-level (also referred to as contrast) using the Lumagen controls, use a test pattern generator or select PLUGE pattern. Note that the input memory black and contrast are intended to compensate for variations in video source output levels. Use a Radiance contrast pattern and the display’s controls to set the display black and white levels. The command is:

MENU → Input → Video Setup → [Resolution] → Picture → (Black, White)

Color Format
Inputs 1, 2 are HDMI. By default the appropriate color space is automatically selected (”Auto” mode) for standard-definition "Bt.601" or high-definition "Bt.709." The ”Auto” mode is generally best, but some upscaling sources do not convert the color format to Bt.709 as they should and so “Bt.601” would be manually selected for these if they are programmed to output HD formats. Bt.601 is used for SD/ED modes and Bt.709 is used for HD modes. The command is:

MENU → Input → Video Setup → [Resolution] → Picture → Color Format → (Auto, Bt.601, Bt.709)

Color and Hue

NOTE:
Set the display’s Color and Hue to their default values.

Use a test pattern generator, or test disc, test pattern to set Color and Hue if necessary. Normally not used if the Color-Gamut is calibrated using the Radiance CMS system, unless the source has an error in its color decoder. The command is:

MENU → Input → Video Setup → [Resolution] → Picture → ColorDecoder →
(Color Offset, Hue Offset, Color Red, Hue Red, Color Green, Hue Green)

Y/C Delay
Adjust the horizontal Chroma timing in relation to Luma. It is suggested that you use a Y/C-delay calibration image from a test pattern generator of test disc to calibrate the Y/C-delay. The C<sub>β</sub> and C<sub>γ</sub> channels are adjusted independently. The command is:

MENU → Input → Video Setup → [Resolution] → Picture → YC Delay → (Cr, Cb)

Input Size Controls
This menu has controls for the capture window for video input. There are settings for the input aspect ratio, size, shift and masking.

Scale Bias
Scaling is normally on in order to adjust the source to exactly fit the output resolution. If the bias is set to ”On”, scaling is enabled unless the input and output resolution match exactly. If the scale bias is set to ”Off” scaling is disabled if the input and output resolutions are close. Scaling is disabled/enabled independently for horizontal and vertical. When the bias is off there can be small borders on the edges of the image. If these areas have bad video the output Mask command can be used to blank that portion of the image. The second page of on-screen status information indicates whether scaling is active.

MENU → Input → Video Setup → [Resolution] → Size → [Aspect ratio] → Scale Bias → OK

Input Sizing
Input sizing can be used to compensate for active image size differences between sources. Note: The input size command does not affect the output size or position. Rather, it affects which input pixels are captured for processing.
Section 5 – Video Configuration

Use the **Crop TopLeft** command to select the top-left-most active input pixel. Use the **Crop BotRight** command to select the bottom-right-most active pixel. For standard-definition sources you should set these controls so that overscan is about 1.5% on all four sides. For digital high-definition sources, overscan may not be required. Cable and Satellite Boxes may require more overscan. Select the scanline using the ▲ and ▼ arrows, and the pixel using the ◀ and ▶ arrows. The command is:

```
MENU → Input → Video Setup → [Resolution] → Size → [Aspect ratio] → (Crop TopLeft, Crop BotRight)
```

**Vertical Shift**

The vertical shift is an easy way to move the image up and down without changing the *Input Sizing* settings. There are 15 vertical settings that are shared between all input memories. Select the vertical shift setting and then the shift value. The command is:

```
MENU → Input → Video Setup → [Resolution] → Size → [Aspect ratio] → Vert Shift → OK
```

**Non-linear Stretch**

Non-linear-stretch (NLS) is used to horizontally stretch a 4:3 aspect ratio source to fit a 16:9 aspect ratio display or to stretch a 16:9/1.85 source to fit a 2.35 aspect ratio display. The image is stretched by a constant amount in the center and by an increasing amount approaching the left and right edges. This eliminates the black sidebars normally seen when viewing lower aspect material on a higher aspect display. To use non-linear stretch press the “4:3”, “16:9” or “1.85” button and then press the “NLS” button.

The goal is to stretch the image to fill the screen in a way that looks as natural as possible. The Lumagen NLS command is very flexible and allows the image to be adjusted to user preferences to achieve this goal. The NLS adjustments are center width, center stretch, top cropping and bottom cropping. The center section of the image is stretched by a constant ratio from 100% to 124%. The width of the center section can be set from 15% to 70% of the display width. By programming the center section width and stretch amount, the amount of non-linear stretch in the left and right sections can be optimized. In addition, the top and bottom cropping can be set from 0 to 12%. Increasing the amount of cropping reduces the amount of stretch near the left and right edges of the image. When setting the cropping parameters, it is recommended that the satellite/cable box menu be checked to assure that critical parameters remain visible.

Some 4:3 sources fill the entire source image (e.g. DVD 16:9 movies), but other sources place a 4:3 image in the center of a 16:9 image (e.g. HDTV with up-scaled SD source). This latter case is seen as a “pillar-boxed” image with black bars on the left and right. The “PILLARBOXED” parameter must be enabled for this case. The Lumagen will then crop the pillbox bars and stretch the active 4:3 image.

For a 16:9 display, when 4:3 NLS is enabled, the image will fill the screen with a 4:3 (1.33) source for any output aspect ratio up to 1.85. If the output aspect ratio is greater than 1.85, software limits the maximum width to the equivalent of 1.78 and adds left and right sidebars.

For a 2.35 display, when 16:9 NLS is enabled, the image will fill the screen with a 16:9 or 1.85 source for any output aspect ratio up to 2.40. If the output aspect ratio is greater than 2.40, software limits the maximum width to the equivalent of 2.40 and adds left and right sidebars.

Select the parameter to adjust using the ▲ and ▼ arrows, and change the value of the selected parameter using the ◀ and ▶ arrows. The command is:

```
MENU → Input → Video Setup → [Resolution] → Size → [Aspect] → NLStretch → OK
```

**Input Masking**

The masking command allows you to cover up the sides of the video source. It is different then cropping in that the video is not stretched to fill the screen. It can be useful for pass-through modes where you do not wish the Radiance to scale the picture if there is some video noise on top/bottom/side of the picture that you want to cover up. Another situation may be that you wish to cover up and change the gray level of the black bars added by a video source, surrounding a letterboxed image.

When you select the command you must first select which mask number you wish to use. There are 15 available masks. They can be shared among different input memories. After selecting the mask number you then can adjust how much the mask covers of the 4 sides of the input. The last step is to alter the gray level for the 4 sides. If an input mask is on, it’s gray level takes precedence over the gray level of the aspect bar. The aspect bar gray level can be adjusted under Output->Configs->[Config]->Other->Graybar. Also, if aspect bars are requested (via differing input and output aspects) the masking is added to the aspect bar width. The command is:

```
```
Section 5 – Video Configuration

**Input Control Menu**

**Deinterlacing Mode**
The default deinterlacing mode is “Auto.” This mode automatically switches between video and film deinterlacing and is best for mixed-mode sources that change between video and film. For sources that are known to be interlaced-video, choosing “Video” deinterlacing mode can improve image quality. For sources that are known to be film sources, choosing 'Film' deinterlacing mode can improve image quality. For 60Hz interlaced film sources the output must be one of 24, 48, 60, or 72 Hertz, and for 50Hz interlaced sources the output rate must be 50 Hertz. For “Film” mode, Sharpness, Noise Reduction and Adaptive Contrast settings are not available. The command is:

MENU → Input → Video Setup → [Resolution] → Control → Deint → Mode→ (Auto,Video,Film)

**Inter Frame Motion Detection (IFMD)**
For deinterlacing video sources (not applicable for film) the IFDM control trades-off between minimizing combing artifacts (small values) verses maximizing detail (larger values) using the IFMD setting. The default setting is 6. This control is most effective with “Video” deinterlacing mode. The command is:

MENU → Input → Video Setup → [Resolution] → Control → Deint → IFMD→ (0-15)

**Deinterlacing Field Flip**
Some source devices do not follow conventions for the order of video fields. This can be seen as excessive combing in the video. While generally not required, this command allows the input fields to be swapped so these out-of-spec sources can be properly deinterlaced. The command is:

MENU → Input → Video Setup → [Resolution] → Control → Deint → Field → (On, Off)

**Genlock**
Genlock is used to minimize video delay, for 480i/1080i to 24Hz conversion, and to avoid an occasional dropped or repeated frame. It can slow down source and mode changes, so Lumagen recommends setting Genlock to ‘off’ for cable and satellite set top boxes. The command is:

MENU → Input → Video Setup → [Resolution] → Control → Deint → Genlock → (Auto, Disabled)

**Game Mode**
To minimize video processing latency, when playing video games, turn “Game Mode” on. Interlaced sources 480i/576i/1080i are treated as 240p/288p/540p. Deinterlacing, and Enhance settings are not available. Typically game mode is enabled for a specific input memory that is then selected while playing games. For games that have a vertical rate that matches the Radiance output vertical rate, turning “Genlock” on can further minimize video latency. Game mode is not intended for video/film program material, such as television shows. The command is:

MENU → Input → Video Setup → [Resolution] → Control → Game Mode → (On, Off)

**Reinterlace**
Adds reinterlacing for 480p and 576p sources. This can provide dramatic improvements to a picture that has been poorly deinterlaced prior to coming into the Radiance. Reinterlacing also allows for taking in 480p/576p movies and going out at 24/48/72Hz. With this command you can “allow” or "disallow" quick remote key control for a particular resolution as well as turn it on/off. If "Reinterlace <> Keys" are set to ‘allow’ the left/right arrow buttons on the remote can then be used to control reinterlacing. The left arrow toggles reinterlacing on/off and the right arrow toggles the field order. Depending on how the picture was deinterlaced, the field order may or may not be important but it can be quickly toggled to see if there is any difference. The command is:

MENU → Input → Video Setup → [Resolution] → Control → Reinterlace

**Input Enhancement Controls**

**Sharpness**
This command is used to adjust the sharpness for all inputs. There are controls for horizontal, vertical and diagonal sharpness (edges) and texture (fine detail). It is generally best to leave these controls at the default setting of 0 or to use moderate settings. Using higher settings can introduce image artifacts. Some people prefer having all 6 settings set the same. Other people prefer only using the diagonal parameters. The command is:

MENU → Input → Video Setup → [Resolution] → Enhance → Sharpness → OK
Section 5 – Video Configuration

Noise Reduction
Mosquito noise and block artifact noise are both seen in compressed material. The Radiance has both temporal and special noise reduction to help reduce the noise level these artifacts introduce into the image. Block artifact reduction is also supported and can be useful with overly compressed video. The command is:

MENU → Input → Video Setup → [Resolution] → Enhance → Noise Red. → OK

Adaptive Contrast
Adaptive Contrast varies the contrast based on the average level of the central 60% of the picture. When you adjust the contrast the effect is shown in a centered window for evaluation. The command format is:

MENU → Input → Video Setup → [Resolution] → Enhance → AdapContrast → OK

Copy Enhancement Settings
You can copy the local enhancement settings to other resolutions and memories. The command is:

MENU → Input → Video Setup → [Resolution] → Enhance → Copy → OK

Miscellaneous Input Controls

Input Label
Each input configuration memory can be named. Follow the on-screen directions. The < and > arrows select which input to change and then which character to change. The ▲ and ▼ arrows change the selected character. The command is:

MENU → Input → Label → OK

Copy Input Settings
Copy the input settings between memories. Applicable input settings can be copied between inputs. Copying the first input memory calibrated to other input memories can speed up the calibration process. The input copy command copies all user memory parameters to another input or user memory. The command is:

MENU → Input → Copy → OK

Selecting an Output Configuration for an Input Memory

NOTE:
The following section assumes that software 102910 or later is installed in your Radiance.

The output-Mode, CMS and Style for each sub-memory can be set independently. Each input memory “resolution sub-memory” points to a Mode, a CMS, and a Style memory. For HD capable inputs, each memory has eight resolution “sub-memories” which are set to default values of 480, 576, 720p60, 1080i50, 1080i60, 1080p24, 1080p60 and Other and automatically selected based on the input resolution and rate. The “Other” sub-memory is used for any input resolution that isn’t one of the specified input resolutions.

See the “Video Output Setup” Menu section for additional information on connecting an input memory to an output Mode, CMS and Style.
Section 6 – Audio Configuration

The Radiance supports the HDMI 1.4 audio formats. This means that Dolby Digital TrueHD™ and DTS Master-Audio™ are available.

By default the audio EDID from the device connected to the HDMI Output is passed back to the source devices. There are two methods that can be used to change this. Typically the audio menu (MENU → Audio) is used to program the audio EDID mode. For most cases the audio menu is all that is needed to setup the audio EDID. However, in some cases a specific input, or input memory, may need to use a different audio EDID. In this case the audio EDID for each input memory can be changed (MENU → Audio → Audio EDID).

Introduction to the Audio Menu

The Audio menu configures the audio EDID reported back to HDMI sources and is independent of the Video EDID mode. In addition it selectively enables audio output based on the specified conditions. Many common system configurations can use the default Audio mode settings. Some examples of these are:

- HDMI television (with audio) connected to HDMI Out
- HDMI receiver connected to HDMI Out with a display connected to the receiver’s HDMI output

**NOTE:**

Associating an audio input with a video input is done using the Input menu
MENU → Input → Audio Setup → Source → (audio source) → OK.

**NOTE:**

For best switching, and power-on, times manually select the output resolution and select "USER1 EDID" for the audio mode. For example, for a 1080p60 display pressing MENU 0 2 7 OK selects 1080p60 and eliminates the need for the Radiance to read the display video EDID. Selecting "Always", and "USER1 EDID" in the Audio menu eliminates the need for the Radiance to read the audio EDID information from the AVR/TV. See the Output Configuration Commands section, and Audio section, for more information. Remember to save any changes.

Some important concepts for selecting the audio configuration are:

- Audio from the active HDMI Input can be routed to the HDMI output.
- HDMI audio EDID reported back to the HDMI sources can be passed-back from the HDMI output, or specified by the user (User EDID).
- Some sources update their EDID information only when they are powered on, or do not properly reread EDID when the HDMI Hotplug signal is toggled. If you have a source that reads EDID only at power-on, or does not respond properly to Hotplug, a single EDID mode should be enabled (e.g. select “always report user EDID” as described below).
- Selecting "User1 EDID" is the recommended practice. This allows the Radiance to report the EDID back to the HDMI sources even when the display or receiver is turned off. This can also significantly shorten the system boot time. However, in this case, care must be taken to select only audio modes that the audio processor supports.
- Default "User EDID" mode is 2-channel PCM and Dolby-Digital 5.1 only. The user can change the "User EDID" to include any audio modes supported by the Radiance and the audio processor.
- Audio EDID, and the audio output enable, are global parameters. The Audio EDID mode is independent of the Video EDID mode.
- You can over-ride the global Audio EDID for a particular HDMI input by selecting MENU → Input → Audio Setup → Audio EDID → Custom → Ok. Set the audio modes to “Y” (yes) that you want to report back the source for that input.
- Audio is muted when changes are detected on the input. Some audio receivers need to be muted longer to avoid unintended noise. MENU → Input → Audio Setup → Mute Control → Long → Ok
Section 6 – Audio Configuration

Audio Menu Navigation
You can change the setting for any item in the Audio menu by first navigating to the item using the remote's arrow buttons and then pressing the "OK" button. The item will begin flashing to indicate it is active for change. Use the arrow buttons to change the setting. Press the "OK" button to accept the setting or the "EXIT" button to cancel. The highlight will stop flashing and a new item can be selected.

Audio Menu Selections
The audio menu can have up to three entries. These are:

<table>
<thead>
<tr>
<th>Audio EDID to Report</th>
<th>User Mode Select</th>
<th>HDMI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passback Output EDID</td>
<td>PCM 2Ch 44.1Khz</td>
<td>Y</td>
</tr>
<tr>
<td>User1 EDID</td>
<td>PCM 2Ch 48Khz</td>
<td>Y</td>
</tr>
<tr>
<td>User2 EDID</td>
<td>PCM 2Ch 96Khz</td>
<td>N</td>
</tr>
<tr>
<td>User3 EDID</td>
<td>PCM 2Ch 192Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>PCM 5.1 44.1Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>PCM 5.1 48Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>PCM 5.1 96Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>PCM 5.1 192Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>PCM 7.1 44.1Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>PCM 7.1 48Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>PCM 7.1 96Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>PCM 7.1 192Khz</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DD 5.1Ch</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>DD 7.1Ch</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DD+ 5.1Ch</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DD+ 7.1Ch</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DTS 5.1Ch</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DTS 7.1Ch</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DD HD 5.1Ch</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DD HD 7.1Ch</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DTS HD 5.1Ch</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>DTS HD 7.1Ch</td>
<td>N</td>
</tr>
</tbody>
</table>

Audio Menu Structure
Audio setup is global. In contrast, the video EDID is selected in the input memory "EDID Setup" on a “per-input-memory” basis, and the audio EDID is globally selected based on the HDMI output. Both the video EDID capability and the audio EDID capability can be passed back from the HDMI output or user defined.

Audio User EDID
When selecting specific audio modes, the up and down arrow keys select an entry and the right arrow key is used to turn that mode on or off.

Input Memory Specific Audio EDID
If an input, or input memory, requires a specific EDID, it can be configured in the audio setup menu. Each input memory can be configured to use the global audio EDID, or a specific list of audio modes to report back to the source. The command is:

MENU → Input → Audio Setup → Audio EDID

Audio Source Selection Defaults
To change the audio source for a particular input, first select that video input, and then select the desired audio source. Any number of video inputs can be linked to the same audio source. The command is:

MENU → Input → Audio Setup → Source → (select audio input) → OK

The video inputs are linked to the following audio sources by default.

<table>
<thead>
<tr>
<th>Input Number</th>
<th>Video Input Type</th>
<th>Audio source</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HDMI</td>
<td>HDMI1</td>
</tr>
<tr>
<td>2</td>
<td>HDMI</td>
<td>HDMI2</td>
</tr>
</tbody>
</table>
Section 7 – Calibration

Your theater system needs to be calibrated. To brighten the image in the show room, most display manufacturers intentionally change the display calibration away from industry standards. Unfortunately most displays do not have the controls necessary to undo these errors. Correcting these intentional errors, and other unintentional errors, so the image appears as the producers intended, is a primary function of the Radiance. The Radiance has a host of features dedicated to this task.

It is recommended that a professional calibrator be hired to perform the calibration. An experienced professional calibrator has the necessary tools and experience to extract the best performance from your theater. However, you can improve your picture without hiring a professional if you prefer. You will need to learn how to use the Lumagen test patterns, or use a calibration disc (such as AVIA, Digital Video Essentials, or Spears & Munsil High-Definition Benchmark). Then you need to spend time learning how various calibration controls interact and how they affect image quality.

To understand Radiance calibration, it is important to note that setup and calibration parameters are split into “input memories” and “output configurations.” Input memories are for source specific setup and calibration. Output configurations deal with display setup and calibration. These are covered elsewhere in this manual.

It is recommended that the internal Lumagen test patterns be used to calibrate the output configuration. This will assure that any variance between sources (size, color or levels) do not affect the calibration of the display. Note that some professional calibrators prefer to use a test pattern generator for all calibration functions. This method can also work well. After the display has been calibrated, differences between inputs can be calibrated using test patterns played on the source devices or test pattern generators.

The recommended Lumagen calibration sequence is shown below.

Set the display’s picture controls to neutral

- Disable enhancement features on the display. Features such as sharpness, DRC and certain color mode settings do not live up to their advertising and can actually reduce image quality. In addition the Lumagen enhancement features work best when the display is set to have its own enhancement features disabled.
- Select the display color temperature setting that is closest to the “D65” for white. This is often referred to as “D65,” “warm,” or “cinema” color mode, but this varies between manufacturers.

Calibrate black and white levels using display controls

- To calibrate the black and white levels in the display, select the Lumagen contrast test pattern. Use the right-arrow key to select the Contrast 1 (or Contrast 2) test pattern. The Contrast 1 pattern has two white rectangles and two black rectangles. In the dark areas, there are two vertical bars, one at 4 IRE and one at –4 IRE. The white area has two vertical bars, one at 96 IRE and one at 104 IRE. Note that 0 IRE is reference black and 100 IRE is reference white. Since –4 and 104 are outside the nominal black to white range, not all displays will show these levels. The test pattern command is:

```
MENU → Other → Test Pattern → Reference → OK
```

**NOTE:**

"L and R arrow" selects pattern group, "U and D arrow" adjusts IRE on some patterns, "2" hides menu, "4" steps through patterns in group, "CLR" completely exits, "Ok" exits & leaves pattern up. If exiting with "Ok" you can toggle between live video and the test pattern with "Prev" and use "Alt" to jump back to the test pattern command.

To change the test pattern timeout:

```
MENU → Other → Menu control → Timeouts → Test pattern timeout → (Normal, Slow, Never) → Ok
```

- Adjust the black level using the display’s brightness control. Adjust so that the 4 IRE bar is barely visible against the black background (0 IRE). There should be no visible difference between the black background areas and the –4 IRE bar. This is a secondary indication verses the 4 IRE bar, but can be useful in optimizing the black level in displays that support blacker-than-black.
- Adjust the white level using the display’s contrast control. Adjust so that the 96 IRE bar is still visible against the white (100 IRE) background. If a display supports whiter-than-white, the 104 IRE bar may be visible. This is not a requirement, but does show if there is headroom above white.
Section 7 – Calibration

- Check your results with a realistic image. Some displays can be adjusted so that the 96 IRE bar is visible but the image does not look its best due to a too-high contrast setting. In this case adjust the display’s contrast control to reduce the maximum brightness until the video image looks good.

- If either the 4 IRE and/or 96 IRE bars cannot be made visible after adjusting the controls, check that the appropriate Lumagen output level (Video or PC) has been selected. The command is:

  \[
  \text{MENU} \rightarrow \text{Output} \rightarrow \text{Styles} \rightarrow \text{[Style]} \rightarrow \text{HDMI Format} \rightarrow \text{Type} \rightarrow \text{(PC, Video)}
  \]

Color Management

The Radiance Color Management System (CMS) controls are used to calibrate display grayscale tracking, gamma plus primary, and secondary, colors. The use of these controls requires advanced knowledge and special equipment. We suggest that a qualified video technician be hired to do this calibration.

Calibrate 100 IRE white to D65 using the display’s controls

- Note that Lumagen recommends that a qualified video technician be hired to calibrate grayscale.

- It is best to calibrate the 100% white point color-of-gray in the display if possible. If the display has a custom grayscale control, calibrate the 100% white point using the Radiance Gamut white-point (not the parametric gray-scale 100% setting) as described below. Otherwise skip this step.

- To calibrate the 100 IRE color-temperature point using the display’s controls, select the Lumagen 100 IRE window test pattern. This pattern has a white window on a black background. Navigate to the Lumagen test pattern menu and then use the right-arrow key to select the 100 IRE Window test pattern. The command is:

  \[
  \text{MENU} \rightarrow \text{Other} \rightarrow \text{Test Pattern} \rightarrow \text{Reference} \rightarrow \text{OK}
  \]

- Adjust the color temperature of 100% white to D65 using the display custom grayscale calibration controls. Note that, if the color gamut is to be calibrated, the selected color temperature in the display should be one where the red, green and blue primaries are at or outside the CIE color triangle for the desired color space.

- If the display 100% White Point cannot be calibrated, select a “Color Mode” in the display that gives a result for the 100% White Point that is closest to the D65 specification. The use the Radiance CMS “White” calibration to adjust the 100% White Point.

- Some high-end displays have advanced calibration menus. An experienced calibrator may choose to use some of these features to do additional calibration before calibration is completed using Lumagen controls.

Calibrate Radiance primary color gamut

- Many digital displays have over-saturated primaries. The Radiance CMS controls allow the characteristics of the primary and secondary colors to be corrected. Note that the primary colors can only be repositioned within the triangle that is defined by the position of the display’s uncorrected primary colors. If a display has under saturated primary points (such as on typical CRT based displays) they cannot be corrected.

- Note that if needed in the Radiance, the 100% white point should be adjusted using the gamut white-point calibration rather than the grayscale calibration menu.

- The Radiance menu mode must be set to “Service mode” to make changes. The command is:

  \[
  \text{MENU} \rightarrow \text{Other} \rightarrow \text{Menu control} \rightarrow \text{Menu mode} \rightarrow \text{Service mode} \rightarrow \text{OK}
  \]

- The gamut calibration command usage is described in a Tech Tip on the Lumagen support web page. The command is:

  \[
  \text{MENU} \rightarrow \text{Output} \rightarrow \text{CMS’s} \rightarrow \text{[CMS]} \rightarrow \text{Color Gamut} \rightarrow \text{OK}
  \]

Calibrate Radiance grayscale and gamma

- Grayscale and gamma should be calibrated at this point. Calibrating these parameters is an essential part of the video calibration process. The display should have been set to a color temperature close to D65, and the 100 IRE white point should be calibrated using the display controls, if feasible, or the Radiance gamut white-point. Then the Lumagen parametric grayscale controls should be used to calibrate the other gray levels.
Section 7 – Calibration

- The Gamma Factor adjusts the gamma of the video output up or down. Since the Radiance is in the middle of the video chain, its default goal is to not affect the image Gamma and so the default Radiance gamma is 1.00. Changing the Gamma Factor allows the Radiance a “coarse correction” control for display Gamma. It should be set to (Desired_Gamma / Measured_Gamma). The command is:

  
  MENU → Output → CMS’s → [CMS] → Gamma Factor → OK

- Grayscale calibration adjusts the "color of gray" so that the color "gray" adheres to industry standards (D65 point for color images), at all levels from black to white. Gamma is the response curve between black and white and also has an industry defined standard that should be followed. Lumagen has developed a unique 2,5,11,12 or 21 point parametric grayscale/gamma calibration feature, which allows both grayscale and gamma to be optimized over the entire range from black to white, and not just at one or two points. The command is:

  
  MENU → Output → CMS’s → [CMS] → Gray/Gamma → OK

- After completing the output calibration, copy the results to all configuration memories. The command is:

  
  MENU → Output → Copy → OK

- It is a good idea to save the configuration before proceeding. The command is:

  
  MENU → Save → Save → OK → OK

Iterate the gamut and grayscale/gamma calibrations

- Since the gamut and grayscale/gamma calibrations interact to some degree, it is important to repeat both until good results for both are achieved. Note that the following step, color/hue, also interacts with these controls.

Calibrate Radiance output color and hue

- If gamut, grayscale/gamma have been calibrated using a color probe, or spectral radiometer, and the display suffers from red-push, green-push, or blue-push, the Output Configuration color and hue controls can be used to correct the resulting errors in flesh tones.

- If no gamut or grayscale calibration has been done, color and hue, and color/hue offsets can still be used to improve color fidelity using colorbar patterns and color filters. It should be noted that color filters are not ideal and so whenever possible gamut, grayscale/gamma and color/hue should be calibrated using a color probe or a spectral radiometer as noted above. Set the Color (Color) and Hue (Hue) controls in the Radiance output menu using a colorbar pattern and a blue filter. The procedure used to accomplish this is described on DVD test discs such as AVIA. Next set the red color (Color Red) and Hue (Hue Red) offsets using a red colorbar pattern and a red filter. Finally set the green color (Color Green) and Hue (Hue Green) offsets using a green colorbar pattern and a green filter. Set the menu mode to "service mode," select Radiance color-bar pattern with the menu command. While the pattern is displayed, pressing menu leaves the pattern up and directly selects the color/hue menu. The command is:

  
  MENU → Other → Test Pattern → Adjustable → [select pattern] → OK

  MENU → Output → CNS’s → [CMS] → ColorDecoder → OK

Iterate gamut, grayscale/gamma and color/hue calibrations.

- Since the gamut, grayscale/gamma, and color/hue calibrations interact to some degree, it is important to repeat all three steps until good results for both are achieved.

Calibrate Radiance input overscan, black, white, color and hue

- While generally not needed, the Radiance provides four independent input configuration memories for each input, MemA through MemD. Calibration for each input is independent of the other inputs and multiple independent calibrations can be done for each input. One use for the multiple calibrations for each input is to calibrate MemA for day and MemB for night viewing. Also, each input memory has separate calibrations for each of eight input resolutions [See the Memory Configuration section]. Typically the DVD, or Bluray, input is calibrated first, using a DVD, or Bluray, calibration disc, or you can connect a video test pattern generator. Then the results of this calibration are then copied to all input memories as a reference starting point for the other sources. However, any source can be calibrated first if you prefer.
Section 7 – Calibration

- Set the Lumagen input aspect ratio as **4:3** (1.33) for a 4:3 screen, **16:9** (1.76) for a 16:9 screen, or **2.35** for a projector with a 2.35 anamorphic lens. The input aspect ratio should be set before adjusting the overscan.
- Display an “Overscan” test pattern from the selected source.
- Adjust the input size and position. This selects which pixels are captured. Adjust the top-left corner of the image first. Then adjust the bottom-right corner. For digital 1080i/p 16:9 sources input size should only be adjusted if absolutely necessary for 1080p 16:9 screens, so that the scaling will remain off, which in turn will keep the image as sharp as possible. The command is:
  
  MENU → Input → Video Setup → [Resolution] → Size → [Aspect] → (Crop TopLeft, Crop BotRight)

- Display a “contrast” or a “Needle Pulses” test pattern.
- Set the black level. Since the Lumagen-to-display levels were set above in the Output Calibration section, the Lumagen internal input-memory Black level control should be used. This allows differences between sources to be corrected. Note that many cable and satellite services use different black levels for standard definition and high-definition sources. Using a Radiance video processor is one of the few ways you can correct this error. It is recommended that you use a low average picture level test pattern, which has a black frame with two moving bars (2 and 4 IRE) for setting black level. The reason is that the black level varies with the average intensity on the screen for many displays. Since the black level is most critical in dark scenes this will provide the best setting. The command is:

  MENU → Input → Video Setup → [Resolution] → Picture → Black → OK

- Set the white level (contrast). Since the Lumagen-to-display levels were set above in the Output Calibration section, the Lumagen internal input-memory Contrast control should be used. The command is:

  MENU → Input → Video Setup → [Resolution] → Picture → White → OK

- Display a “Colorbar” test pattern, sometimes referred to as an “SMPTE bar” test pattern.
- Set Color and Hue and then the Color and Hue offsets for red and green. The display’s Color and Hue should have been set to default before performing any calibration steps. First set Color and Hue using the blue colorbar pattern and the blue filter. Next set the red color (Color Red) and Hue (Hue Red) offsets using the red colorbar pattern and the red filter. Finally set the green color (Color Green) and Hue (Hue Green) offsets using the green colorbar pattern and the green filter. The command is:

  MENU → Input → Video Setup → [Resolution] → Picture → ColorDecoder → OK

- Display a “Y/C Delay” test pattern.
- Set Y/C Delay. Use the Lumagen Control to minimize the error in the blue and red timing verses Luma. The Cb and Cr channels are calibrated independently.

  MENU → Input → [Resolution] → Picture → YC Delay → OK

- You may wish to copy the calibrated configuration to all configuration memories as a starting point.

  MENU → Input → Copy → OK

- If desired, change to MemB and repeat the above steps to calibrate for a different amount of room light.
- Calibrate the other inputs.
- Name the inputs, if desired. The command is:

  MENU → Input → Label → OK

- Lock the configuration, if desired. The command is:

  MENU → Other → Menu Mode → Locked → OK

- **SAVE THE CONFIGURATION**

  MENU → Save → Save → OK → OK
Section 8 – Miscellaneous Commands

System Settings

Menu Mode
The menu mode controls what settings can be changed in the menu. In Locked mode nothing can be changed in User Mode, Service Mode (temporary) and Service Mode (permanent). The default setting is User Mode, which allows access to all the basic controls. The Service Mode allows access to all controls including the color gamut controls. The configuration can be locked to prevent unintended changes. When locked, input selection functions normally, but setup parameters are fixed. The command is:

MENU → Other → Menu control → Menu Mode → (Locked, User mode, Service mode temporary, Service mode permanent)

Timeouts
In the "Normal" setting the menu and test patterns will timeout in approximately three minutes. The "Slow" setting extends the timeout by x10. Test patterns also have a setting for "Never" timeout. The command is:

MENU 0 9 0 5 (Normal, Slow) Ok

or MENU → Other → Menu control → Timeouts → (Normal, Slow, Never)

OSD Enable
Enable or disable On-Screen-Display (OSD) activation after user commands. If enabled, the OSD shows the selected input, input aspect ratio, and zoom. The command is:

MENU → Other → Menu control → OSD enable → (On, Off)

Input Reselect
If this is set to "On", then when the currently active input is reselected the input will be reinitialized and the input number will be displayed. The command is:

MENU → Other → Menu control → In Reselect → (On, Off)

Menu Placement
In the "Standard" placement the menu is in the center of the screen. Choose "Center open" to move the menu so that the center of the screen is open for display calibration measurements. The command is:

MENU → Other → Menu control → OSD enable → Menu placement → (Standard, Center open)

Input Menu
The Input Menu option enables a pop up list of inputs you can select from when the "Input" button is press on the remote. The command is:

MENU → Other → Menu control → Menu Options → Input Menu → (Off, On)

Initial Power State
When power is first connected, the unit can be set to turn on automatically, or it can be set to go to standby-mode. The command is:

MENU → Other → OnOff Setup → Auto On → (Standby, Turn On)

Initial Input State
This sets which input and input memory is selected when unit is turned on, either after power has been removed or the unit has been put into standby. The command is:

MENU → Other → OnOff Setup → Input Select → (After Power Removed, After Standby)
Section 8 – Miscellaneous Commands

On/Off Message
A programmable string can be sent to another device via the RS-232 connector to turn the device on or off. The command is:

\[ \text{MENU} \rightarrow \text{Other} \rightarrow \text{OnOff Setup} \rightarrow \text{(On Message, Off Message)} \]

Message Control
This sets the RS-232 parameters that are used for sending a power on/off message to another device. The command is:

\[ \text{MENU} \rightarrow \text{Other} \rightarrow \text{OnOff Setup} \rightarrow \text{Message Ctl} \]

Test Patterns

\begin{itemize}
  \item Warning: Test patterns can burn plasma and CRT displays if left on for more than a few seconds.
\end{itemize}

The user can select from a large selection of test patterns. While in the test pattern menu the \(<\) and \(>\) arrows select a test pattern group. Press the "4" button to step through the test patterns in a group. For many test patterns the intensity can be adjusted from 0 to 100 IRE, in 5 IRE steps, using the \(^{\uparrow}\) and \(^{\downarrow}\) arrows. Reference test patterns are only affected by the output PC/Video level setting. Adjustable patterns allow viewing the effect of the output color management settings. The Warm Up test pattern displays a 20 IRE to 50 IRE gray screen.

To exit the test pattern command but leave the pattern on-screen, press "OK". You can then adjust various parameters to judge their effect on the pattern. Press "Prev" to then toggle between the source and the pattern. Press "Alt" to jump back into the pattern command. The "Prev" and "Alt" functions are only valid if leave the pattern on-screen by pressing "OK". The ten video inputs are numbered 1 to 10. For inputs 1 through 9, press the "Input" button and then press the corresponding number button on the remote. For input 10, press the "Input" button, then the "0" button. The command is:

\[ \text{MENU} \rightarrow \text{Other} \rightarrow \text{Test Pattern} \rightarrow \text{Pattern} \rightarrow \text{(Reference, Adjustable, Warm up)} \]

Remote Control

Allows changing the default command usage of the arrow buttons on the remote. By default the Up/Down arrow buttons can be used to control zoom. The Right/Left arrow buttons can be used to select the input aspect ratio. You can turn off these additional functions by selecting "Off". The command is:

\[ \text{MENU} \rightarrow \text{Other} \rightarrow \text{I/O Setup} \rightarrow \text{Remote Ctl} \rightarrow \text{(Up/Down arrows, Rt/Left arrows)} \rightarrow \text{(On, Off)} \]

LED Setup
This command controls the operation of the Green LED on the front panel. The LED can be set to "Green" to be a power on indicator or set to "Dark" so that it is off when the Radiance is operating. The command is:

\[ \text{MENU} \rightarrow \text{Other} \rightarrow \text{I/O Setup} \rightarrow \text{LED Setup} \rightarrow \text{(Green, Dark)} \]

RS-232 Setup
With echo on the Radiance will echo all characters sent to it. With echo off the Radiance will only send a message at power on/off. With echo set to off with status, the power on/off messages are changed to status responses. See Tech Tip 11 for delimiter usage and more details. The command is:

\[ \text{MENU} \rightarrow \text{Other} \rightarrow \text{I/O Setup} \rightarrow \text{RS-232 Setup} \rightarrow \text{(Echo, Delimiters)} \rightarrow \text{(On, Off)} \]

3D Glasses

\begin{itemize}
  \item NOTE: Generally 3D displays/projectors control the 3D glasses. In this case this command is not used.
\end{itemize}

These settings control the Lumagen 3D Eyeglass Adapter when it is connected the HDMI output on the Radiance. The delay setting adjusts when the shutter-glasses switch eyes. If the 3D effect doesn't look correct it may be that the left and right eyes are swapped. Changing the polarity will correct this. The command is:

\[ \text{MENU} \rightarrow \text{Other} \rightarrow \text{I/O Setup} \rightarrow \text{3D Glasses} \rightarrow \text{(Delay, Polarity, Enable)} \]
Section 8 – Miscellaneous Commands

Zoom Step
This command sets the size of the Zoom step to 5% or 15%. The command is:

MENU \(\rightarrow\) Other \(\rightarrow\) Zoom step \(\rightarrow\) (5\%, 15\%)

Quick Keys
This adds an optional top-level menu called “Quick Keys” that gives access to functions that are normally selected using buttons on the Lumagen remote. This menu can be used with programmable remotes that have limited buttons. You can use the arrow buttons on the remote to highlight one of the functions and press “Ok” to execute the function. Alternately you can use a number button on the remote to highlight one of the functions and then press “Ok” to execute the function. (0)4:3, (1)LBOX, (2)16:9, (3)1.85, (4)2.35, (5)NLS, (6)Zoom+, (7)Zoom-, (8)MemA, (9)MemB, (n/a)MemC, (n/a)MemD, (n/a)3D Off, (n/a)3D SbyS, (n/a)3D TopB. The command is:

MENU \(\rightarrow\) Quick Keys \(\rightarrow\) (function) \(\rightarrow\) Ok

Configuration Memory Usage
By default, when a configuration memory (A-D) is chosen the selection applies to all inputs. For example if input 1A is active, then input 2 is selected followed by selecting “MemB,” if input 1 is again selected, it would use configuration memory 1B. This is called the “Common” configuration memory mode. Generally this mode is used when specific day and night calibrations are desired and used for all inputs.

You can set the memory usage to be “Per Input.” That is the configuration memory selection is independent for each input. In this mode, using the example above, starting with input 1A, changing to input 2, pressing “MemB” and finally selecting input 1, results in using configuration memory 1A. The command is:

MENU \(\rightarrow\) Other \(\rightarrow\) Memory Usage \(\rightarrow\) (Common, Per Input)

Saving the Configuration

Save

NOTE:
If a Save command is not executed after making changes, the changes will be lost when the unit is put into standby power mode, or if power is interrupted.

Permanently save the current configuration. Note that, once saved, the configuration is retained even if the unit is disconnected from power. The configuration from the previous save is retained to allow one level of save-undo. You can use the Radiance Configuration Utility found on the Lumagen.com support page to store a configuration file on your PC. The command is:

MENU \(\rightarrow\) Save \(\rightarrow\) Save \(\rightarrow\) OK \(\rightarrow\) OK

Undo

Revert to the configuration over-written by the last Save command. Repeating the Save Undo command toggles between the last two saved configurations. The command is:

MENU \(\rightarrow\) Save \(\rightarrow\) Undo \(\rightarrow\) OK

Restore ISF calibration

During calibration, the video technician can save the resulting Lumagen configuration to a special hidden configuration memory. This command restores that configuration in the event that the user inadvertently changes the configuration. A Save is required to make the restore permanent. The command is:

MENU \(\rightarrow\) Save \(\rightarrow\) Restore ISF \(\rightarrow\) OK

Revert To Factory Settings

Set all parameters to factory defaults. A Save is required to make the settings permanent. The command is:

MENU \(0\ 9\ 9\ 9\)

Or MENU \(\rightarrow\) Save \(\rightarrow\) FactoryReset \(\rightarrow\) OK
Section 9 – 3D Support

The Radiance supports HDMI 1.4 “3D”. This includes 3D video source switching, 3D processing, 3D scaling, 3D aspect ratio control, and 3D format conversion. The Radiance can vertically stretch 3D images for a 2.35 screen on systems that use an anamorphic lens. The Radiance can accept HDMI 1.4 “3D” material and output either the left-eye or right-eye image, for dual projector 3D systems that use passive 3D glasses. The Radiance can also be used to display 3D on many 2D displays, such as a CRT display or projector.

If a HDMI output on the Radiance is connected to a non-3D AVR the Radiance can automatically turn off video on that output when selecting a 3D video source. Some non-3D AVR’s get confused if you try to send them a 3D video signal.

Any HDMI cable, with good electrical characteristics, will work for displaying HDMI 1.4 3D video on 3D displays.

3D Types

The Radiance can receive all the commonly used 3D types. The Radiance has options to convert 3D types, which are not supported by your 3D display, to a format supported by the display. For example the Radiance automatically converts optional 3D formats into required 3D formats. For CRT displays all supported 3D formats are converted to 3D Frame Sequential. This allows 2D CRT displays/projectors to display 3D images.

Frame Packed

Consists of a frame that contains a full resolution left eye image, 45-pixel active buffer, and a full resolution right eye image. Bluray movies use this 3D type and are stored on the disk at 1920x2205/24.

Side-by-Side

Consists of a frame that contains Side-By-Side sub-frames for the left eye and right eye images. Set top boxes and PC’s use this 3D type.

Top-Bottom

Consists of a frame that contains Top-Bottom sub-frames for the left eye and right eye image. Set top boxes and PC’s use this 3D type.

Frame Sequential

Consists of individual frames of left eye and right eye images that are transmitted sequentially. Some 2D CRT and other 2D digital displays can be driven with this 3D type in order to display 3D images. For this case, an external IR Glass Driver is needed to drive the 3D active glasses.
Separate Left and Right
The Radiance can accept HDMI 1.4 “3D” video and output either the left-eye or right-eye image for a dual projector 3D system that uses passive 3D glasses. This 3D system configuration uses two Radiance video processors.

3D Output Settings
The Radiance has support for all of the commonly used 3D video sources. If you connect a HDMI 1.4a compliant 3D video source and compliant 3D display, to the Radiance, you should automatically get a 3D image, using the Radiance default settings.

The Radiance has settings that you can use to display 3D video, using non-compliant 3D video sources and displays. The Radiance has settings to optimize the video on your 3D display. The Radiance also has settings to display 3D video on some 2D displays (See section titled “3D Support for 2D Displays” for further details).

3D Output Setup Menu
You can select the 3D output settings based on the input number, input memory, and input video mode. For any of the three input conditions you can select ‘All’ to apply the output setup to multiple input conditions. When making settings that apply to multiple input conditions you can leave any of the output settings unchanged by selecting the '-' option for that output setting. Press "4" for ‘All’ and press "5" to see the current settings. The command is:

MENU → Output → Output Setup → 3D → Ok

3D Output Mode = Auto
By default the output is set to “Auto 2,1.” The selection "Auto 2,1" means the Radiance automatically reads the EDID for the devices connected to both outputs, giving priority to Output 2, and automatically selects the appropriate output resolution. That is, if an active device is connected to output 2, the EDID from that device is read to determine the optimal video output resolution and the Radiance automatically selects the specified resolution. If no device is connected to output 2, or the device connected to output 2 is turned off, the Radiance uses the EDID from the device connected to Output 1 and sets the output resolution appropriately. Output 1 can have priority by selecting "Auto 1,2" from the Video Output Select Menu.

For “Auto” modes the output vertical rate is selected based on the input vertical rate. For example, input formats 480i60, 720p60, 1080i60 automatically select a vertical output rate of 60 Hertz. Input formats 576i50, 720p50, and 1080i50 automatically select a vertical output rate of 50 Hz. For a 1080p24 input format a 24 Hz output vertical rate is selected if the display supports a 24 Hz output vertical rate, otherwise a 60 Hz rate is selected.

If the priority output is connected to a 3D device, and the secondary output’s device is not 3D, when a 3D source is detected the Radiance automatically disables video to the 2D output.

For analog displays and digital displays, that do not properly support EDID, the output mode must be selected.

3D Output Mode = Specific Format
The Radiance will convert all 3D input formats to the specified 3D output format. For example all 3D input modes can be converted to a 1080p60 side-by-side output mode.

3D Output Type = Auto
The Radiance has support for all of the commonly used 3D Types (Frame Packed, Side-by-Side, Top-Bottom, and Frame Sequential). When the output ‘Type’ is set to ‘Auto’ the Radiance will convert all 3D modes and types to HDMI 1.4a mandatory 3D format.

3D Output Type = Specific 3D Type
The Radiance will convert all 3D input types to the specified 3D output type. i.e. All 3D input types can be converted to 3D Frame Sequential to drive a CRT display/projector.
Section 9 – 3D Support

3D EDID Configuration

By default the display’s 3D capability is automatically detected using its EDID information. However, some 3D displays do not properly report their 3D capability in their EDID. This command allows the 3D output capability to be manually enabled (or disabled). The command is

```
MENU → Output → 3D Options → (Out1, Out2) → (Auto, Yes, No)
```

3D Setup Procedures

Normal Setup

For most new 3D video sources and displays, just connect the source and display to the Radiance. You will get a 3D image, with the Radiance default settings of 3D output 'Mode=Auto' and 3D 'Type=Auto'.

1. If starting with a unit in an unknown state, press "MENU 0999" to restore factory default settings and save the new settings by pressing "MENU → Save → Save → OK → OK”.
2. Connect the Radiance outputs. If using only one Radiance output, use Output 1 if the Radiance needs to pass audio, or Output 2 if not. If using an AVR, or audio PrePro, connect it to Radiance Output 1 and the display to Output 2.
3. Connect a video source that supports 3D to a HDMI input on the Radiance.
4. Turn on power to the display and video source.
5. You should now have a 3D image on your display.

Display Optimization

To get the best quality 3D image, on some displays, it is necessary to convert some or all of the 3D video modes to a specific 3D output mode. Research the display specifications, to determine the optimum 3D modes and types for your display.

For example; If a display shows 720p 3D video as a letterboxed image. You can set the Radiance to convert 720p 3D video to 1080p60 Side-by-Side 3D video, which is shown full screen on the display.

1. Set the appropriate Radiance output to “3D Capable” by pressing "MENU → Output → 3D Options → OK → (Out1/Out2) → Yes → Ok”.
2. For example; to set the Radiance 3D output to "1080p60" "Side-by-Side”, press "MENU → Output → Output Setup → 3D → Ok → Mode → 1080p60 → Type → SbyS → Ok". Note: You need to select a 3D output mode before you can select a specific 3D output type.
3. Save the new settings by pressing "MENU → Save → Save → OK → OK”.

Setup for Non-Compliant Displays

The Radiance also has settings to display 3D video on non-compliant displays.

1. If starting with a unit in an unknown state, press "MENU 0999" to restore factory default settings.
2. Connect the Radiance outputs. If using only one Radiance output, use Output 1 if the Radiance needs to pass audio, or Output 2 if not. If using an AVR, or audio PrePro, connect it to Radiance Output 1 and the display to Output 2.
3. Connect a video source that supports 3D to a HDMI input on the Radiance.
4. Turn on power to the display, Radiance and video source.
5. Set the appropriate Radiance output to “3D Capable” by pressing "MENU → Output → Output Setup → Ok → (Out1/Out2) → Yes → Ok”.
6. Save the new settings by pressing "MENU → Save → Save → OK → OK”.
Section 9 – 3D Support

Setup for Non-Compliant Video Sources
The Radiance also has settings to display 3D video using 3D video from non-compliant video sources. It is only necessary to manually set the 3D input mode on the Radiance if the video source doesn’t transmit that it’s displaying a 3D mode.

1. If starting with a unit in an unknown state, press "MENU 0999" to restore factory default settings.
2. Connect the Radiance outputs. If using only one Radiance output, use Output 1 if the Radiance needs to pass audio, or Output 2 if not. If using an AVR, or audio PrePro, connect it to Radiance Output 1 and the display to Output 2.
3. Connect a video source that supports 3D to a HDMI input on the Radiance.
4. Turn on power to the display, Radiance and video source.
5. The Quick Key Menu has settings to set the Radiance input to 2D, 3D Side-by-Side, or 3D Top Bottom mode, press "MENU → Quick Keys → (3D Off, 3D SbyS, 3D TopB) → Ok”.
6. The direct commands to set the Radiance input to 2D, 3D Side-by-Side, or 3D Top-Bottom is:
   - 2D "MENU 030"
   - 3D Side-by-Side "MENU 031"
   - 3D Top-Bottom "MENU 032"
7. This setting isn’t saved. Use the Quick Key Menu or a direct command to set the 3D input mode on the Radiance, when using a non-compliant 3D video source.

3D Support for 2D Displays
The Radiance has a setting for “Frame Sequential” output for 3D. This allows some 2D CRT or digital displays to show 3D video at 720p50/60 or 1080p50/60. If your 2D display can run at higher rates such as 72, 96, 100 (in Europe), or 120 Hertz; these would be better choices. Note: The 50/60 Hz 3D modes can have a lot of flicker since each eye sees 25/30 Hz, but it is an inexpensive way to view 3D games or video without having to purchase a new 3D display.

You will need a Radiance 3D, a Lumagen “CRT-3D” sync box” (with a DIN-3 connector on the output) or the PC 3D-glasses output option on the RadianceMini-3D, PC 3D infrared emitter (with a DIN-3 connector on the input), and the appropriate 3D glasses.

Normally the 3D glasses polarity and phase is controlled by the 3D display. If you have a CRT projector or "3D ready” digital display, and you are using the Lumagen "CRT-3D” sync box, the Radiance controls the 3D-glasses polarity and phase.

Some displays don’t have a constant delay from input to output at 60 Hertz. This will affect 3D on these non-3D displays because the 3D glasses timing changes over time as the display’s internal delay varies. For these displays the phase on the Radiance might require frequent adjustment.

1. If starting with a unit in an unknown state, press "MENU 0999" to restore factory default settings.
2. Connect the Radiance output to the display.
3. Connect a video source that supports 3D to a HDMI input on the Radiance.
4. Turn on power to the display, Radiance and video source.
5. Set the Radiance output to “3D Capable” by pressing "MENU → Output → 3D Options → Ok → (Out1/Out2) → Yes → Ok”.
6. For example; to set the Radiance 3D output mode to “1080p60” "Frame Sequential”, press "MENU → Output → Output Setup → 3D → Ok → Mode → 1080p60 → Type → FSeq → Ok".
   Note: You need to select a 3D output mode before you can select a specific 3D output type.
7. Save the new settings by pressing "MENU → Save → Save → OK → OK".
Section 10 – Command Interface

Direct Commands

Direct Commands are entered by using the Lumagen remote control or RS232 interface.

See Radiance Tech Tip 13 “Direct Commands and Menu Shortcuts” which contains a complete list of commands. This Tech Tip is available for download at http://www.lumagen.com.

Output Vertical Resolution

480p: MENU 0 2 1 Progressive with 480 active scanlines
540p: MENU 0 2 2 Progressive with 540 active scanlines
720p: MENU 0 2 4 Progressive with 720 active scanlines
768p: MENU 0 2 5 Progressive with 768 active scanlines
1080p: MENU 0 2 7 Progressive with 1080 active scanlines
1080i: MENU 0 2 8 Interlaced with 1080 active scanlines

Output Mode Commands

Output 2D: MENU 0 3 0 Set output mode to 2D
Output 3D-SBS: MENU 0 3 1 Set output mode to 3D Side-By-Side
Output 3D-TB: MENU 0 3 2 Set output mode to 3D Top-Bottom

Output Vertical Rate

Set vertical rate: MENU 0 4 (50Hz, 60Hz) OK

Output Aspect Ratio

Output aspect ratio: MENU 0 6 value OK Example: For 16:9 enter178

Miscellaneous Commands

S/W Rev MENU 0 9 0 3 Display software revision and serial-number
Menu timeout MENU 0 9 0 5 Toggle menu timeout. Short (default) or long (saved)
Service Mode MENU 0 9 1 0 Toggle SERVICE MODE. (not saved)
Reinterlace Off MENU 0 9 4 0 Turns reinterlacing off
Reinterlace On MENU 0 9 4 1 Turns reinterlacing on
Toggle field order MENU 0 9 4 2 Toggles field order for reinterlacing
Unlock menu MENU 0 9 1 5 Can also be selected using menu
Output defaults MENU 0 9 9 8 Reset current output to default for current resolution
Factory defaults MENU 0 9 9 9 Reset to factory default (Must “Save” to make permanent)

Menu Shortcuts

See Radiance Tech Tip 13 “Direct Commands and Menu Shortcuts” which contains a complete list of commands. This Tech Tip is available for download at http://www.lumagen.com.

IR Command List

See Radiance Tech Tip 12 “IR Command Interface” which contains a complete list of IR commands. This Tech Tip is available for download at http://www.lumagen.com.

ASCII Command List

See Radiance Tech Tip 11 “RS232 Command Interface” which contains a complete list of RS232 commands. This Tech Tip is available for download at http://www.lumagen.com.
Section 11 – Specifications

Input
- 2 video/audio HDMI® 1.4 inputs:
  - 480i to 1080p60, plus HDMI 1.4a 3D formats

Processing
- 10-bit processing front-end with 12-bit calibration pipeline
- Proprietary Lumagen “No-ring” ™ scaling
- Support for HDMI 1.4a “3D”
- Each input has 4 user configuration memories, with 8 resolution sub-memories for each
- 2:2, 3:2 and 3:3 pull-down for SD/HD film sources
- Per-pixel SD/HD video de-interlacing
- Adaptive diagonal filtering
- MPEG mosquito and block artifact reduction
- Temporal noise reduction for SD/HD sources
- User programmable non-linear-stretch (NLS) mode, 4:3 to 16:9 or 16:9/1.85 to 2.35
- 4:3, LBOX, 16:9, 1.85, 2.35 and NLS input aspect ratios
- Programmable output aspect ratio from 1.33 to 2.50
- Support for anamorphic lenses
- Extensive suite of test patterns
- Parametric grayscale calibration, 2,5,10,11 or 21 point
- Parametric Gamma calibration, 2,5,10,11 or 21 point
- Programmable input/output color-space
- Y/C-delay calibration
- User-adjustable image enhancement
- CUE and ICP filtering
- Supports HDCP

Output
- 1 HDMI 1.4 “3D”, 480p to 1080p and 1080i
- Eight channel audio at 192 kHz
- HDMI inputs and outputs support DD True-HD™, and DTS Master Audio™
- HDMI output provides “stand-by” power to external device of +5V at 50 mA

Miscellaneous
- IR and RS232 control (See Tech Tip 11 and 12 on the www.lumagen.com website)
- Universal Power Supply, INPUT: 100-240V at ~50/60Hz. OUTPUT: 5.0 VDC, 4.0A
- Power consumption: 13 Watts